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TPS-1 

TPS-1 ソリューション ボード スタートアップ マニュアル 

要旨 

本書は、TPS-1 Solution ボードの使用方法について説明します。TPS-1 Solution ボードは、お客様に独自

のハードウェアを準備することなく、PROFINET 通信用 LSI TPS-1 を評価するための環境を提供致します。 
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1. 概要 

1.1 概要 

本書は、TPS-1 を使った TPS-1 Solution ソリューションボードの使用方法について記載しております。 

本ボードは、TPS-1 シリーズの通信評価を行うことを目的とし、以下のインターフェースを搭載していま

す。 

・10Base-T / 100Base-TX (PROFINET)  

・UART(USB mini-B) 

・外部インターフェース（SPI、パラレル I/O インターフェース、パラレル・バス・インターフェース

etc.） 

・その他、LED、スイッチなど 

 

 

 

 

  



TPS-1 TPS-1 ソリューション ボード スタートアップ マニュアル 

R18AN0033JJ0100  Rev.1.00  Page 6 of 78 

2017/04/25  

2. TPS-1 Solution ボード ハード構成 

2.1 ボード構成 

以下の 3 種類のボードで構成されます。TPS-1 のメインボードを主として、I/O ボード又は CPU ボードと

接続することで、パラレル I/O インターフェース、CPU とのパラレル HOST インターフェース、シリアル

HOST インターフェース（SPI）評価が可能となります。 

1) TPS-1 メインボード  :  PROFINET 通信用 

2) I/O ボード           :  パラレル I/O インターフェース動作確認用 

3) CPU ボード       :  パラレル及びシリアル HOST インターフェース（SPI）動作確認用 

(RX231 搭載) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

【注】 I/O ボードと CPUボードは、メインボードと接続することで動作致します。 

図 2-1 ボード構成 

 

 

  

1) TPS-1 メインボード 

2) I/O ボード 3) CPU ボード 
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3. 一般仕様 

3.1 電気仕様 

本章では、本ボードの電気的仕様及び性能を一覧表形式で説明します。 

 

Item Specification 

Power 
supply 

Rated Voltage DC5V 

Status LED(PWR) Red 

 

3.2 仕様 

 

Item Specification 

Main LSI TPS-1 (Operating frequency 100MHz) 

Interface Ether 2ch RJ-45(w/ built-in pulse-trans) 

USB 1ch(Mini-B) virtual COM port(UART) 

JTAG 1ch 10pin half pitch for ICE connection 

External I/F 68pin FX2-68P-1.27DSL(71) of HIROSE 

LED Power 1bit Red LED 

PROFINET 4bit Red LED / Green LED/Yellow LED 

PHY_Link 1bit(2ch) each Green LED 

Activ 1bit(2ch) each Green LED 

Power supply DC Jack/USB +5.0V 

Operation 
temperature 

0～+55℃ 
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3.3 環境仕様および質量 

 

Item Specification 

Physical 
Environment 

Ambient operating temp 0～+55℃ 

Preservation ambient temp -25～+70℃ 

Ambient operating humidity 30～90%RH(no condensation) 

Preservation ambient 
humidity 

30～90%RH(no condensation)) 

Use atmosphere No corrosive gas 

Weight Main board 50 gram 

CPU board 30 gram 

IO board 25 gram 

Dimension Main board 74mm(W)×74mm(D)×34mm(H)  

(excluding the protuberance) 

CPU board 74mm(W)×74mm(D)×11mm(H)  

(excluding the protuberance) 

IO board 74mm(W)×74mm(D)×10mm(H)  

(excluding the protuberance) 

 

3.4 通信仕様 

 

Item Specification 

Communication protocol PROFINET IO 

Communication control IC TPS-1 

PROFINET PHY Internal 

Communication system IEEE802.3u(100base-TX) 

Insulation system Pulse transformer 
insulation 

External interface RJ45 x 2ch 

Status LED BF(Red)、SF(Red)、READY(Green)、MT(Yellow) 

ACT0(Yellow)、ACT1(Yellow)、 

Link0(Green)、Link1(Green) 
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4. TPS-1メインボードの各ブロックと名称説明 

4.1 TPS-1 メインボード ブロックダイアグラム 

 

 

図 4-1 TPS-1 Main Block diagram 

 

4.2 TPS-1 システムクロック 

TPS-1 の基準クロックとして、オシレータから 25MHz を供給します。TPS-1 のシステムクロックは内部で

4 逓倍され、100MHz となります。 

 

図 4-2 Clock Circuit 
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4.3 外部メモリ（シリアルフラッシュメモリ） 

TPS-1 のスタック用としてシリアルフラッシュ(1Mbyte)メモリを実装しています。PROFINET IO のスタッ

クや機器情報を格納します。 

ソケット対応しているため、他の型番に容易に変更することができます。 

 

図 4-4 Serial Flash Memory 

 

4.4 電源 

DC Jack または USB より、DC5V を入力し TPS-1 用の電源を供給します。 

5.0V 通電時、POWER_LED（Green）が点灯します。 

DC Jack
DC+5V

Digital 3.3V

FB

Digital 1.0V

Analog 1.0V

Power Supply　IC
AMS1117-3.3

FB Analog 3.3V

USB
Micro-B

Power Supply　IC
BD9328EFJ-E2

TPS-1

 

図 4-5 Power Supply 
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4.5 PROFINET IO 

TPS-1 から内蔵 PHY を介し PROFINET IO 通信を行います。外部コネクタとして、RJ45(トランス内蔵)を

2Ch 実装しています。 

 

図 4-6 PROFINET IO Communication 
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4.6 UART 

TPS-1 メインボード上には UART to USB 変換の LSI(FT232RQ)が実装されており、USB コネクタを接続し

PC 等との非同期通信を行います。コネクタは USB micro-B を実装しています。 

後述する Terminal Program を使用し、USB を介して TPS-1 と通信することで、TPS-1 の設定やファームウ

エァのアップデートが可能となります。 

 

図 4-6 UART 

 

CN1 

Pin 番号 信号名 

1 VBUS 

2 USB_DM 

3 USB_DP 

4 GND 

5 GND 

 

 

4.7 リセット回路 

パワーオン時にはリセット IC によって、TPS-1 をリセットする回路になっています。 

パワーオン状態でリセットスイッチを押すと、リセット IC を介してシステムがリセットされます。 

CPU ボードと接続している場合は、CPU ボードから、TPS-1 をリセット可能です。ただし、RX231 のサ

ンプルプログラムに、リセット処理を追加する必要があります。 

 

図 4-7 リセット回路 

  

SW10 

SW1 

CN1 
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4.8 LED 

4.8.1 PROFINET インジケーター 

リファレンス番号：LD1, LD2 ,LD3, LD4 

部品型番：BR1111C-TR、PG1111C-11-TR、FY1111C-TR 

PROFINET の動作確認用の赤色 / 緑色 / 黄色 LED (4bit)です。 

BF (赤色) 

SF (赤色) 

READY (緑色) 

MT (黄色) 

 

4.8.2 Power インジケーター  

リファレンス番号：LD5 

部品型番：BR1111C-TR 

電源モニタ用の赤色 LED (1bit)です。 

 

 

図 4-9-2 LED(TPS-1 Main Board) 

 

 

 

 

  

LD1 –LD4 ;  

PROFINET Indicator 

LD5 : 

 Power indicator 
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4.9 モード スイッチ 

基板上のモードスイッチに関して説明します。 

 

 

図 4-10 モードスイッチ (TPS-1 メインボード)  

 

4.9.1 TRSTN ジャンパー J2 

JTAG インターフェース用の切り替えジャンパーです。本ボードでは未使用のため、ジャンパーJ2 を 2-3

に固定して下さい。 

J2 

 

 

4.9.2 Boot モード切り替え ジャンパー J6 

Boot モード切り替えジャンパーです。 通常は Flash モードに設定して下さい。 

フラッシュメモリにデータが書き込まれていない場合、本ジャンパーによる Boot モード設定に拠らず、

UART モードで起動します。 

フラッシュメモリに書き込まれたデータを消去する場合には、UART モードに切り替えます。 

J6 

 

  

J2: TRSTN ジャンパー 

J6: Boot シャンパー 
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4.10 基板間インターフェース J14 

本コネクタを使用することで、I/O ボード、CPU ボードと接続可能となります。 

 

図 4-11-1 基板間インターフェース (TPS-1 メインボード) 

 

図 4-11-2 基板間インターフェース  ピン配列 (TPS-1 メインボード) 

  

J14: 基板間インターフェース 
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5. CPUボード 

5.1 概要 

本ボードは、CPU に RX231 を搭載しており、TPS-1 メインボードと接続することで、シリアル Host イン

ターフェース、パラレル Host インターフェース 8bit /16bit に対応しています。 

 

5.2 コネクタ、スイッチ、LED 

 

 

図 5-2  Connector ,Switch and LED (CPU ボード) 

 

5.2.1 リセットスイッチ SW10 

SW10 を押すことにより、CPU にリセットをかけることが可能です。 

（回路構成は、4.7 章 リセット回路を参照して下さい。） 

 

5.2.2 汎用スライドスイッチ SW11 

汎用的に使用できるスライドスイッチを設けています。スイッチの ON/OFF 状態を CPU のポートで取り

込むことができます。 

SW11 

 

 

 

  

SW Pin No. Ter mi nal  name ( RX231)
1 P44

2 P45
3 P46
4 P47

SW10: Reset Switch 

CN3: E1 用
Debugger 

connector 

SW12:汎用プッシュ Switch 

SW11: 汎用 Slide 

switch 

VR1-4:汎用ボリューム 

LD8-11 : 汎用 LED 



TPS-1 TPS-1 ソリューション ボード スタートアップ マニュアル 

R18AN0033JJ0100  Rev.1.00  Page 17 of 78 

2017/04/25  

 

5.2.3 汎用プッシュスイッチ SW12 

汎用的に使用できるプッシュスイッチを設けています。トリガー信号として CPU のポートで取り込むこ

とができます。 

SW12 

 

 

 

5.2.4 汎用 LED LED8-LED11 

 汎用的に使用できる LED を設けています。 

LED8-11 

 

 

 

 

 

  

SW Pin No. Ter mi nal  name ( RX231)
1 P31
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5.3 パラレル HOST インターフェースのバス幅切り替え用ジャンパー 

パラレル HOST インターフェースのバス幅切り替え用です。8bit と 16bit 幅を切り替えます。 

 

図 5-3 バス幅切り替え用ジャンパー 

 

5.3.1 バス幅 切り替え 

使用するバス幅に合わせて、以下の通りに設定して下さい。 

 

J15-J17 

 

 

 

 

 

 

 

  

バス幅切り替え用

ジャンパーJ15-J17 
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6. I/Oボード 

6.1 概要 

本ボードは、TPS-1 メインボードと接続することで、Remote I/O としての動作し、パラレル I/O 動作の確

認が可能となります。また、本ボードは、LED 8 個とスライドスイッチ 8 個で構成され、入出力それぞれ、

8bit の I/O 動作が可能となります。 

 

6.2 スイッチ、LED 

 

 

図 6-2 LED and Switch  

 

 

6.2.1 OUTPUT表示用 LED 

 

チャンネル TPS-1 の信号名 LED 

CH0 GPIO8 LED1 

CH1 GPIO9 LED2 

CH2 GPIO10 LED3 

CH3 GPIO11 LED4 

CH4 GPIO12 LED5 

CH5 GPIO13 LED6 

CH6 GPIO14 LED7 

CH7 GPIO15 LED8 

 

  

LED 

スライドスイッチ 
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6.2.2 INPUT 用スライド Switch 

チャンネル TPS-1 の信号名 Switch 

IN0 GPIO16 SW2 

IN1 GPIO17 SW3 

IN2 GPIO18 SW4 

IN3 GPIO19 SW5 

IN4 GPIO20 SW6 

IN5 GPIO21 SW7 

IN6 GPIO22 SW8 

IN7 GPIO23 SW9 
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7. TPS-1 設定環境の準備 

7.1 TPS-1 Development Toolkitの準備 

7.1.1 PROFINET TPS-1 Development Toolkitのダウンロード 

Phoenix Contact 社の Home page より、ユーザー登録を行い、PROFINET TPS-1 Development Toolkit 一式の

ダウンロードを行います。尚、ユーザー登録からダウンロード可能になるまで、数日を要します。 

URL は、以下となります。 

https://www.phoenixcontact-software.com/en/downloads 

   

図 7-1-1 Download site for TPS-1 Development Toolkit 

 

7.1.2 アプリケーションのインストール 

TPS-1 Development Toolkit 内のアプリケーションをインストールする。 

以下のインストーラーをそれぞれ、実行する。 

TPS Development Toolkit V.x.x.x.xx¥TPS Configurator¥Setup¥TPS Configurator.msi 

TPS Development Toolkit V.x.x.x.xx¥TPS FWUpdater¥TPS FWUpdater.msi 

TPS Development Toolkit V.x.x.x.xx¥PROFINET Configurator¥PROFINET Configurator.exe 

TPS Development Toolkit V.x.x.x.xx¥PROFINET Smart Control¥PROFINET Smart Control.msi 
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7.1.3 GSDMLファイルの準備 

GSDML ファイルの準備を行います。ここでは、ルネサスエレクトロニクスで作成した GSDML ファイルを

例に説明します。 

尚、TPS Development Toolkit V.x.x.x.xx を、以降は、TDT とします。 

TDT¥GSDML 内に GSDML ファイル一式を保存します。 

 

 

図 8-1-2 GSDML ファイルの準備  
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8. TPS-1 スタックの準備 

8.1 TPS-1スタックイメージファイルの作成 

フラッシュメモリに書き込むためのイメージファイルを作成します。 

 

8.1.1 Vendor IDと Device IDの設定 

ヘッダーファイル(TDT¥TPS_Stack¥hdr.txt)を開き、3 行目を任意の VenderID_DeviceID に変更し、保存しま

す。 

本ドキュメントでは、Renesas の Vendor ID（HEX）を例にして、説明を致します。 

Vendor ID 02C7 (Renesas) 

Device ID 1234 

 

図 8-1-1 Vendor ID と Device ID の設定 
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8.1.2 イメージファイルの作成 

１）以下のバッチファイルをダブルクリックします。 

TDT¥TPS_Stack¥make_Target_Image.bat 

同フォルダ内に、以下のイメージファイルが生成されます。 

TPS_Target_Debug.img （こちらは、使用しないで下さい。） 

TPS_Target_Release.img 

  

図 8-1-2-1 イメージファイルの作成 

  

1) bat ファイルをダブルクリックする 

2) イメージファイルが作成される。 
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２）DAT ファイル名をリネームします。 

 TDT¥TPS_Stack¥0174_1234_lupd.dat をヘッダーファイルに指定した VendorID,DeviceID に合わせて、

VenderID_DeviceID_01upd.dat とリネームします。 

 

 

図 8-1-2-2 DAT ファイルのリネーム  

  

ファイルをリネームする。 
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8.2 TPS-1 Ethernet Updaterイメージファイルの作成 

 

8.2.1 ヘッダーファイルの変更 

ヘッダーファイル(TDT¥TPS UpdaterETH¥updhdr.txt)を開き、3 行目を任意の VenderID_DeviceID に変更し、

ファイルを保存します。 

Vendor ID ：02C7 (Renesas) 

Device ID ：1234 

 

 

図 8-2-1 Vendor ID と Device ID の設定 

 

8.2.2 イメージファイルを作成する。 

TDT¥TPS_UpdaterETH¥make_Updater_Image.bat をダブルクリックすると、 

同フォルダ内に、以下のイメージファイルが生成されます。 

TPS_UpdaterTarget.img 

 

  

図 8-2-2-1 イメージファイルの作成 

 

1) bat ファイルをダブルクリックする。 

2) イメージファイルが作成される。 
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２）DAT ファイル名をリネームします。 

 TDT¥TPS_Update ETH¥0174_1234_01upd.dat をヘッダーファイルに指定した VendorID,DeviceID に合わせ

て、VenderID_DeviceID_01upd.dat とリネームします。 

 

 

図 8-2-2-2 DAT ファイルのリネーム  

 

 

 

 

 

  

ファイルをリネームする。 



TPS-1 TPS-1 ソリューション ボード スタートアップ マニュアル 

R18AN0033JJ0100  Rev.1.00  Page 28 of 78 

2017/04/25  

8.3 TPS FWUpdater用Workフォルダの作成 

8.3.1 Workフォルダの作成 

任意の Work フォルダを作成します。ここでは、Work フォルダ名を TFTP_WORK として、以降は、このフ

ォルダ名で説明します。 

TDT¥TFTP_WORK 

 

図 8-3-1 WORK フォルダの作成 

  

8.3.2 Workフォルダへのイメージファイルのコピー 

以下のファイルを作成した Work フォルダ内にコピーします。 

TDT¥TPS_Stack¥ 02C7_1234_lupd.dat 

TDT¥TPS_Stack¥ TPS_Target_Debug.img 

TDT¥TPS_Stack¥ TPS_Target_Release.img 

TDT¥TPS_UpdaterETH¥ TPS_UpdaterTarget.img 

 

図 8-3-2 イメージファイルのコピー  

任意の WORK フォルダを作成する 
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9. TPS-1 ソリューションボードの設定環境の立ち上げ 

9.1 TPS-1 メインボードとパソコンの接続 

 

9.1.1 パソコンのネットワーク設定 

パソコンのネットワーク設定は以下の通りとします。 

TCP/IPv4 の設定 

IP Address 192.168.16.105 

 

 

図 9-1-1 ネットワーク設定 

 

9.1.2 TPS-1メインボードとパソコンの接続 

TPS-1 Main ボードの Boot 設定を FLASH モードに設定します。 

パソコンと TPS-1 Main ボードを LAN ケーブルで接続します。 

パソコンと TPS-1Main ボードを USB ケーブルで接続します。 

USB to UART ドライバを PC にインストールします。 

 

 

図 9-1-2 ボードとパソコンの接続 

  

LAN cable 
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9.1.3 Terminal Program の設定 

本ドキュメントでは、例として、TeraTerm を使用しております。 

本 Terminal Program は、ホスト PC と RS-232C インターフェースの COM ポート通信を行います。 

ホスト PC にて Terminal Program（Tera Term）を起動してシリアルポートの設定（ボーレート：115200）

を行って下さい。また、送受信時の改行コードは“CR”に設定します。 

 

 

図 9-1-3-1 ターミナルソフト設定 1 

 

 

図 9-1-3-2 ターミナルソフト設定 2 
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10. TPS-1 ソリューションボード立ち上げ方法 

10.1 TPS-1 Configurationの設定 

10.1.1 スタートプログラム（TPS_Starter.s）の転送 

1) TeraTerm を起動する。 

2) TPS-1 メインボードのリセットスイッチを押す。 

3) TeraTerm 上に、”s”を入力し、PC 上の Enter キーを押す。 

4) TeraTerm 上に、以下のメッセージが現れる。 

 

  

図 10-1-1-1 スタータプログラムの転送 1  

 

上記メッセージが出たら、ファイルの送信を行う。 

File => Send file をクリックする。 

  

図 10-1-1-2  スタータプログラムの転送 2 
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フォルダ(TDT¥TPS_Starter¥)を開き、”TPS_Start.s”を選択し、”開く”をクリックする。 

 

 

図 10-1-1-3 スタータプログラムの転送 3 

 

ファイルを送信します。 

 

  

図 10-1-1-4 スタータプログラムの転送 4 

 

  

2) “開く”をクリック 

1) “TPS_Start.s”をクリック 
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ファイルの送信が完了すると、以下の画面になります。 

 

  

図 10-1-1-5 スタータプログラムの転送 5 

 

“g”を入力して、PC 上の Enter キーを押して終了です。 

 

 

図 10-1-1-6 スタータプログラムの転送 6 

Factory Setting 待ち状態となります。 

 

注意） 一定時間経過すると、エラーが発生します。その場合の対応手順に関して、以下に記します。 
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以下のように、エラー画面が出たら、メインボードのリセットスイッチを押して下さい。 

 

 

図 10-1-1-7 スタータプログラムの転送 7 

 

リセットスイッチが押されると、以下の画面が現れます。 

“ｇ”を入力して、”Enter”キーを押します。 

 

図 10-1-1-8 スタータプログラムの転送 8 
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以下のように、Factory Setting 待ち状態に戻ります。 

 

 

図 10-1-1-9 スタータプログラムの転送 9 
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10.1.2 動作モード別の TPS Configurator 設定 

TPS Configurator を起動します。 

使用するインターフェースによって、以下の１）～３）の設定を行います。 

 

１）TPS-1 Host Serial Interface ( SPI ) 

 

ハードウェア設定：CPU ボードと接続します。ジャンパーピンの設定など、特に不要です。 

 

図 10-1-2-1 SPI ボード設定 

 

TPS-1 Configurator 設定 1：“General Settings” タブ 

下図のように、パラメータを設定して下さい。 

 

図 10-1-2-2 SPI Configurator 設定 1 
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TPS-1 Configurator 設定２：“Host Serial Settings” タブ 

下図のように、パラメータを設定して下さい。 

 

図 10-1-2-3 SPI Configurator 設定 2 

 

以上の設定完了後、”10.1.3 TPS Configurator 設定の送信”のページに進んで下さい。 
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２）TPS-1 Host Interface parallel - 8bit- 

 

ハードウェア設定：CPU ボードと接続し、ジャンパーピン J15-J17 を 1-2 側に設定する。 

 

図 10-1-2-4 Host Interface parallel 8bit ボード設定 

 

TPS-1 Configurator 設定 1：“General Settings” タブ 

下図のように、パラメータを設定して下さい。 

 

図 10-1-2-5 Host Interface parallel 8bit Configurator 設定 1 

 

 

 

 

 

  

CPU Board (RX231) 
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TPS-1 Configurator 設定２：“Host Parallel Settings” タブ 

下図のように、パラメータを設定して下さい。 

 

図 10-1-2-6 Host Interface parallel 8bit Configurator 設定 2 

 

 

以上の設定完了後、”10.1.3 TPS Configurator 設定の送信”のページに進んで下さい。 
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３）TPS-1 Host Interface parallel - 16bit- 

 

ハードウェア設定：CPU ボードと接続し、CPU ボードのジャンパーピン J15-J17 を 2-3 側に設定する。 

 

図 10-1-2-6 Host Interface parallel 16bit ボード設定 

 

 

TPS-1 Configurator 設定 1 ：“General Settings” タブ 

下図のように、パラメータを設定して下さい。 

 

図 10-1-2-7 Host Interface parallel 16bit Configurator 設定 1 

 

 

 

 

  

CPU Board (RX231) 
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TPS-1 Configurator 設定２：“Host Parallel Settings” タブ 

下図のように、パラメータを設定して下さい。 

 

図 10-1-2-8 Host Interface parallel 16bit Configurator 設定 2 

 

 

以上の設定完了後、”10.1.3 TPS Configurator 設定の送信”のページに進んで下さい。 
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4）TPS-1 Parallel I/O Interface  

 

ハードウェア設定：I/O ボードと接続します。ジャンパーピンの設定など、特に不要です。 

 

図 10-1-2-8 Parallel I/O Interface ボード設定 

 

TPS-1 Configurator 設定 1 ：“General Settings” タブ 

下図のように、パラメータを設定して下さい。 

 

図 10-1-2-9 Parallel I/O Interface Configurator 設定 1 
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TPS-1 Configurator 設定 2：“IO General Settings” タブ 

下図のように、パラメータを設定して下さい。 

 

図 10-1-2-10 Parallel I/O Interface Configurator 設定 2 
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TPS-1 Configurator 設定 3：“IO Parallel Setting” タブ 

下図のように、パラメータを設定して下さい。 

 

図 10-1-2-11 Parallel I/O Interface Configurator 設定 3 

 

 

以上の設定完了後、”10.1.3 TPS Configurator 設定の送信”のページに進んで下さい。 
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10.1.3 TPS Configurator 設定の送信 

10.1.2 動作モード別の TPS Configurator 設定が完了した後、TPS Configurator の” Ethernet Settings”タブを

選択し、Ethernet 設定を行います。 

MAC アドレスはユーザー固有のアドレスを入力します。ここでは「Renesas Electronics Corporation」を例に

設定します。 

Destination IP    :  192.168.16.227 

  Secure IP        :  192.168.16.105 

  MAC Ethernet    :  74.90.50.00.FC.B8 

  MAC Port1      :  74.90.50.00.FC.B9 

  MAC Port2      :  74.90.50.00.FC.BA  

MAC アドレスの先頭 3byte が 74-90-50 は「Renesas Electronics Corporation」となります。 

入力完了後、最後に”Send configuration”をクリックします。 

 

図 10-1-2-12 Ethernet Settings 画面 

 

以下のメッセージが現れたら、完了です。”OK”ボタンを押して終了して下さい。 

 

図 10-1-2-13 Configurator 完了画面 

“Send configuration”をクリック 
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10.2 TPS-1 Firmwareのアップデート 

 

10.2.1 TPS FWUpdater 用 DAT ファイル編集（その 1） 

Work フォルダ内にある TPS FWUpdater 用 dat ファイル（VendorID_DeviceID_01upd.dat）を開きます。 

以下の設定に書き換えます。 

UpdateTarget = 0 

NextBoot = 1 

UpdateUpdater = 1 

 

注意）本ドキュメントでは、アプリケーション開発を行う場合を想定し、TPS_Target_Debug.img を使用し

ております。製品化の際には、TPS_Target_Release.img をご使用ください。 

Release 版を使用する場合、VenderID_DeviceID_01upd.dat 内の TargetFName で指定されるファイル名を

TPS_Target_Release.img に書き換えて下さい。 

 

 

図 10-2-1 FW Update 手順 1 

 

10.2.2 TPS FWUpdater を起動 

起動時に Preferences 画面が表示されない場合は、Tools=>Preferences で設定画面を開きます。 

Select Network Adapter で、(192.168.16.105)を選択します。 

root directory で、作成した Work フォルダ（例では、TFTP_WORK）を選択します。 

OK ボタンをクリックして、Preferences 画面を閉じます。 

 

 

図 10-2-2 FW Update 手順 2 
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10.2.3 TPS-1 Ethernet updaterイメージファイルの書き込み確認 

Tools=>Bootp/Tftp Logfile を開く 

以下の LOG が出力されるまで待ちます。 

Incoming  readrequest for file : TPS_UpdaterTarget.img 

Incoming  writerequest for file : 192_168_16_2_upd.sts 

 

 

図 10-2-3 FW Update 手順 3 

 

10.2.4 イメージファイル書き込み結果の確認 

WORK フォルダ以下にある、ステータスファイル 192.168.2_ups.sts を開きます。 

[Update Updater]以下、10 行目が performed=yes になっていることを確認します。 

 

 

図 10-2-4 FW Update 手順 4 
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10.2.5 TPS FWUpdater用 DATファイルの編集（その 2） 

WORK フォルダ以下にある、TPS FWUpdater 用 dat ファイル（VendorID_Device_ID_01upd.dat）を開きま

す。 

以下の設定に書き換えます。 

UpdateTarget = 1 

NextBoot = 0 

UpdateUpdater = 0 

 

 

図 10-2-5 FW Update 手順 5 

 

10.2.6 TPS-1スタックイメージファイルの書き込み確認 

Bootp/Tftp Logfile を参照し、以下の LOG が出力されるまで待ちます。 

Incoming readrequest for file : TPS_Target_Debug.img  

Incoming Writerequest for file : 192_168_2_upd.sts 

 

 

図 10-2-6 FW Update 手順 6 
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10.2.7 イメージファイル書き込み結果を確認 

WORK フォルダ以下にある、ステータスファイル 192.168.2_ups.sts を開きます。 

[Update Target]以下、6 行目が performed=yes になっていることを確認します。 

performed=yes になっていれば、FW アップデート完了です。 

 

図 10-2-7-1 FW Update 手順 7 

 

FW アップデート後のログ 

正常にアップデートが完了した場合、Terminal Program 上に、以下の画面が表示されます。 

 

図 10-2-7-2 FW Update 手順 8 
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10.2.8 FW アップデート完了後 

WORK フォルダ以下にある、TPS FWUpdater 用 dat ファイル（VendorID_Device_ID_01upd.dat）を開きま

す。 

以下の設定を行い、完了です。 

UpdateTarget = 0 

NextBoot = 1 

UpdateUpdater = 1 

 

図 10-2-8-1  FW Update 手順 9 

 

 

 

I/O ボードを使用したパラレル I/O モードの場合は、TPS-1 が Host となるため、TPS-1 Main ボード側に

スタックを書き込むことにより、Terminal Program の画面が以下のように表示され、READY 状態となり

ます。 

 

図 10-2-8-2 FW Update 手順 10 
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11. CPUボードのサンプルプログラムの書き込み 

11.1 CPUボード（RX231）とパソコンの接続 

TPS-1 メインボードと CPU ボードを接続します。 

パソコンと CPU ボードとを E1 エミュレータを介して USB ケーブルで接続します。 

TPS-1 メインボードに USB または DC Jack により 5V の電源を供給します。 

 

図 11-2 CPU ボード(RX231)とパソコンの接続 

  

  

USB ケーブル 

5V 給電 
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11.2 CPU用コンパイラパッケージのインストール 

ここでは、CPU 用コンパイラパッケージである CS+がパソコン上にインストールされていて、かつ E1 エ

ミュレータがあることを前提に説明致します。 

   

11.2.1 RX231サンプルプログラム書き込み 

サンプルプログラム内のプロジェクトファイル（rx231_tps1_sampl.mtpj）をクリックします。 

CS+が起動し、以下の画面が立ち上がります。 

 

図 11-2-1-1 サンプルプログラムの書き込み 1 
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使用するインターフェースに合わせて、ビルドオプション(Parallel16bit  or  Parallel8bit  or  SerialSPIIF

を選択します。 

 

図 11-2-1-2 サンプルプログラムの書き込み 2 
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ビルドして、ツールへダウンロードを行います。 

デバッグ(D)=>ビルド&ダウンロード(B) 

 

図 11-2-1-3 サンプルプログラムの書き込み 3 

 

 

 “実行”を選択します。 

デバッグ（D）=>実行(G) 

 

図 11-2-1-4 サンプルプログラムの書き込み 4 
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プログラム実行後、CPU が Host として動作することにより、Terminal Program の画面が以下のように表

示され、READY 状態となります。 

I/O ボードを使用したパラレル I/O モードの場合は、TPS-1 が Host となるため、TPS-1 Main ボード側に

スタックを書き込むことにより、以下の画面のような、READY 状態となります。 

 

図 11-2-1-5 サンプルプログラムの書き込み 5 

 

FW 書き込み完了後、デバッグ=>停止 を選択して停止させます。 

デバッグ(D)=>停止（S） 

 

図 11-2-1-6 サンプルプログラムの書き込み 6 
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デバッグ¥デバッグ・ツールからの切断を選択し、完了します。 

デバッグ（D）=>デバッグ・ツールから切断（N） 

 

図 11-2-1-7 サンプルプログラムの書き込み 7 
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12. PROFINET 通信の立ち上げ 

12.1 PROFINET DEVICE名の定義 

PROFINET DEVICE 名はユーザーが任意に定義できます。本ドキュメントでは、”TPS-1”と定義します。 

 

12.1.1 設定ファイルの作成 

Profinet Configurator 付属の Netnames+を立ち上げます。 

Refresh キーをクリックします。 

 

図 12-1-1-1 Device Name の設定 1 

 

以下の画面に記すネットワーク設定が現れたら、Device Name に”TPS-1”を入力します。 

 

図 12-1-1-2 Device Name の設定 2 
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‘Send’をクリックして完了します。 

 

図 12-1-3 Device Name の設定 3 
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12.1.2 PROFINET Configurator 

PROFINET Configurator を立ち上げます。 

 

12.1.2.1 設定ファイルの読み込み 

設定ファイルを開きます。 

ツールバーで、File=>OPEN を選択します。 

 

図 12-1-2-1 PROFINET Configurator 設定 1 

 

設定ファイルを選択します。既に準備されている下記ファイルを選択して下さい。 

TDT¥PROFINET Configurator¥Example Project¥tps-1.zcp 

 

図 12-1-2-2 PROFINET Configurator 設定 2 

2) 設定ファイルを選択 

3) “開く”をクリック 1) ファイルの種類で ZCP を選択 
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“はい”をクリックします。 

 

図 12-1-2-3 PROFINET Configurator 設定 3 

 

12.1.2.2  Device の登録 

Device Catalog 上に、接続したい機器を登録します。 

１）Device Catalog のエリア内で右クリックを行うと、サブウインドウが表れます。 

２）Import GSD File を左クリックします。 

 

図 12-1-2-4 PROFINET Configurator 設定 4 

 

  

1) このエリアで、右クリックをする。 

2) Import GSD File を左クリック 

“はい”をクリック 
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予め準備した、GSDML ファイルを選択し、Open をクリックします。 

今回の例では、Renesas Electronics で作成した GSDML ファイルを開く方法を説明します。 

 

図 12-1-2-5 PROFINET Configurator 設定 5 

 

今回の例では、Device Catalog に Renesas Electronics の Device が追加されます。 

 

図 12-1-2-6 PROFINET Configurator 設定 6 

 

  

1) GSDML ファイルを選択 

2) Open をクリック 
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12.1.2.3 トポロジーの作成 

 不要な機器を削除します。以下の赤線で囲まれた部分を削除します。 

 

図 12-1-2-7 PROFINET Configurator 設定 7 

 

１）Bus Structure 上から、”PROFINET”を選択します。 

２）トポロジーを組むため、Device Catalog から、追加したいデバイスを選択します。 

今回の例では、Renesas Electronics のデバイスを追加します。 

Renesas Electronics 以下の階層を開き、以下に記した箇所をダブルクリックする。 

  

図 12-1-2-8 PROFINET Configurator 設定 8 

1) PROFINET を選択 

2) Renesas Device をダブルクリックする 
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Bus Structure 上に、PROFINET デバイスが追加されます。 

 

図 12-1-2-9 PROFINET Configurator 設定 9 

 

PROFINET デバイスの IP アドレス範囲を設定します。 

１）Bus Structure 上から、”tps-1”を選択します。 

２）最初に「Last IP Address」を設定します。 

３）次に「First IP Address」を設定します。 

４）最後に「Subnet Mask」を設定します。 

設定する値は、下記の図の通りです。 

  

図 12-1-2-10 PROFINET Configurator 設定 10 

  

2) 192.168.16.254 

3) 192.168.16.2 

4) 255.255.255.0 

2)-4) Set IP-Address range 

1) tps-1 を選択 
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PROFINET IO Controller の設定をします。 

1) Bus Structure 上から、”Phoenix Contact Software PROFINET 192.168.16.201”を選択します。 

2) Device Detals 上の IP Addressa、Subnetmask を入力します。 

例として、以下の IP Address とします。 

 

   

図 12-1-2-11 PROFINET Configurator 設定 11 

 

PROFINET OUTPUT フォルダの設定を行います 

１）Bus Strucure 上で、PROFINET を選択します。 

２）PROFINET¥PROFINET Settings 上の Save parameterization をダブルクリックします 

   

図 12-1-2-12 PROFINET Configurator 設定 12 

 

  

192.168.16.201 

 

255.255.255.0 

2) IO Controller 
settings 

2)このアイコンをダブルクリックする 

1)”PROFINET”を選択します。 

1) Phoenix Contact Software PROFINET 192.168.16.201 を選択 
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Path for download to the file system に TDT¥PROFINET Configurator¥Example Project¥のフォルダを選択しま

す。 

   

図 12-1-2-13 PROFINET Configurator 設定 13 

 

登録した PROFINET デバイスの設定をします。 

１） 下図のように、Bus Structure 上で PROFINET デバイスを選択します。 

２） Device Detail 上で、PROFINET Setting を選択します。 

３） Device Detail 上で、IP アドレスと Subnetmask の値を確認します。 

   

図 12-1-2-14 PROFINET Configurator 設定 14 

 

  

３）IP アドレスと Subnet マスクを確認します。 

192.168.16.2 

 

255.255.255.0 

1)PROFINET デバイスを選択します。 

2) PROFINET Setting を選択します。 
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１）タブを PROFINET Setting から、PROFINET Stationnames に切り替えます。 

利用可能な TPS-1 デバイスが表示されます。 

２）TPS-1 デバイスを選択します。 

３）“Assign Name”をクリックする。 

   

図 12-1-2-15 PROFINET Configurator 設定 15 

 

下図で記すメッセージが出たら、デバイスの割り当てが完了です。 

  

図 12-1-2-16 PROFINET Configurator 設定 16 

  

２)TPS-1 デバイスを選択します 

３)”Assign Name”をクリックします 
1) PROFINET Stationnames を選択します。 



TPS-1 TPS-1 ソリューション ボード スタートアップ マニュアル 

R18AN0033JJ0100  Rev.1.00  Page 67 of 78 

2017/04/25  

Parameterize の実行 

１） Bus Structure 上の“PROFINET”を選択します。 

２）“Parameterize”ボタンをクリックする。 

  

図 12-1-2-17 PROFINET Configurator 設定 17 

  

２）“Parameterize” button を押します。 

1)”PROFINET”を選択します。 



TPS-1 TPS-1 ソリューション ボード スタートアップ マニュアル 

R18AN0033JJ0100  Rev.1.00  Page 68 of 78 

2017/04/25  

“Execute”ボタンをクリックします。 

“はい（Y）”ボタンをクリックします。 

  

図 12-1-2-18 PROFINET Configurator 設定 18 

 

 

１）State が”Completed”となります。 

２）“Close”ボタンをクリックして完了。 

  

図 12-1-2-19 PROFINET Configurator 設定 19 

 

 

 

  

1) “Execute” ボタンをクリックします 

2) “はい（Y）” ボタンをクリックします 

２） “Close” ボタンをクリックします。 

1) State が Complete となります 
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12.2 ソフトウェア PLCとの接続 

12.2.1 PROFINET Smart Control Express 

PROFINET Smart Control Express を立ち上げます。 

XML ファイル”IPPNIO”をロードする。(Application => Parse XML-File) 

TDT¥PFOFINET Configurator¥Example Project¥IPPNIO.xml 

 

  

図 12.2.1 PROFINET Smart Control Express の立ち上げ 1 

 

Device Selection で、TPS-1 を選択します。 

  

図 12.2.2 PROFINET Smart Control Express の立ち上げ 2 
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“START AR’ボタンをクリックします。 

  

図 12.2.3 PROFINET Smart Control Express の立ち上げ 3 

 

AR Connected 及び AR Status が有効になります。 

下図のように、AR Connected と AR Status の表示が緑色に変わりましたら、ソフト PLC との接続完了で

す。 

  

図 12.2.4 PROFINET Smart Control Express の立ち上げ 4 

 

 

  

START AR” ボタンをクリックします 

緑色に変わります。 
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12.2.2 I/Oボードの動作確認 

 

１）マスターからのデータ送信 

PROFINET Smart Control Express の OUTPUT 設定の下位 1byte が TPS-1 のポート GPIO8 から GPIO15 に割り

当てられており、ポートの状態を LED（LED1 から LED8）の点灯・消灯により確認することができます。 

 

PROFINET Smart Control Express の OUTPUT 設定を”0x00FF”に設定することにより、I/O ボード上の LED を

消灯させることができます。 

 

  

図 12-2-2 I/O ボード動作確認 1 

 

２）PROFINET Smart Control Express の OUTPUT 設定を”0x0000”に設定することにより、I/O ボード上の

LED を点灯させることができます。 

 

  

図 12-2-2 I/O ボード動作確認 2 

 

OUTPUT 

INPUT 

INPUT 

OUTPUT 
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３）TPS-1 のポート（GPIO16 から GPIO23）が、PROFINET Smart Control Express の INPUT 設定の上位

1byte に割り当てられており、I/O ボード上のスイッチ（SW2 から SW9）の設定により、PROFINET Smart 

Control Express 上の仮想 LED を点灯又は消灯できます。 

 

I/O ボード上のスイッチ（SW2 から SW9）を ON にすることで PROFINET Smart Control Express 上の仮想

LED を点灯状態にできます。 

  

図 12-2-3 I/O ボード動作確認 3 

 

４）I/O ボード上のスイッチ（SW2 から SW9）を OFF にすることで PROFINET Smart Control Express 上の仮

想 LED を消灯状態にできます。 

  

図 12-2-4 I/O ボード動作確認 4 

 

SW が全て ON の時 

SW が全て OFF の時 

INPUT 

INPUT 

OUTPUT 

OUTPUT 
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12.2.3 CPUボードの動作確認 

１）マスターからのデータ送信 

PROFINET Smart Control Express の OUTPUT 設定の下位 4bit が CPU RX231 のポート PC0 から PC3 に割り当

てられており、ポートの変化を LED(LED8 から LED11)の点灯・消灯で確認することができます。 

 

PROFINET Smart Control Express の OUTPUT 設定を”0x000F”に設定することにより、CPU ボード上の LED

を消灯させることができます。 

 

  

図 12-2-5  CPU ボード動作確認 1 

 

 

２）PROFINET Smart Control Express の OUTPUT 設定を”0x0000”に設定することにより、CPU ボード上の

LED を点灯させることができます。 

 

  

図 12-2-6  CPU ボード動作確認 2 

 

  

INPUT 

OUTPUT 

OUTPUT 

INPUT 
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３）CPU RX231 のポート（P44 から P47）が、PROFINET Smart Control Express の INPUT 設定の上位

1byte の下位 4bit に割り当てられており、CPU ボード上のスイッチ（SW11 の 1pin から 4pin）の設定によ

り、PROFINET Smart Control Express 上の仮想 LED を点灯又は消灯できます。 

 

CPU ボード上のスイッチ（SW11 の 1pin から 4pin）を ON にすることで PROFINET Smart Control Express 上

の仮想 LED を消灯状態にできます。 

 

  

図 12-2-7  CPU ボード動作確認 3 

 

 

４）CPU ボード上のスイッチ（SW11 の 1pin から 4pin）を OFF にすることで PROFINET Smart Control 

Express 上の仮想 LED を点灯状態にできます。 

  

図 12-2-8  CPU ボード動作確認 4 

 

 

  

SW が全て ON の時 

SW が全て OFF の時 

INPUT 

INPUT 

OUTPUT 

OUTPUT 
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13. Appendix A 

13.1 TPS-1 メインボードのフラッシュ消去方法 

ここでは、メインボードのフラッシュ消去方法を説明します。 

13.1.1 フラッシュ消去プログラム（TPS_Erase_Flash.s）の転送 

１）TPS-1 メインボードのジャンパーJ6 を 2-3 に設定し、UART モードに設定します。 

２）パソコンと TPS-1 ボードを USB ケーブルで接続します。 

３）ターミナルソフトを起動します。ここでは、TeraTerm を例に説明します。 

４）TPS-1 メインボードのリセットスイッチを押します。 

５）TeraTerm 上に、”s”を入力し、パソコン上の Enter キーを押す。 

６）TeraTerm 上に、以下のメッセージが現れる。 

 

図 13-1-1 フラッシュ消去手順 1 

 

上記メッセージが出たら、ファイルの送信を行います。 

File=>Send file をクリックします。 

 

図 13-1-2 フラッシュ消去手順 2  

”S”を入力し、パソコン上の

Enter キーを押します 
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フォルダ TDT¥ TPS Starter を開き、” TPS_Erase_Flash.s”を選択し、開く（O）をクリックします。 

 

図 13-1-3 フラッシュ消去手順 3 

 

フラッシュの消去が開始されます。 

 

図 13-1-4 フラッシュ消去手順 4 
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フラッシュの消去が完了すると、以下の画面になります。 

 

図 13-1-4 フラッシュ消去手順 4 

 

“g”を入力して、PC 上の Enter キーを押して終了。初期状態に戻ります。 

 

図 13-1-5 フラッシュ消去手順 5 
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ホームページとサポート窓口 

ルネサス エレクトロニクスホームページ 

http://japan.renesas.com/ 
 

お問合せ先 

http://japan.renesas.com/contact/ 
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製品ご使用上の注意事項 

ここでは、マイコン製品全体に適用する「使用上の注意事項」について説明します。個別の使用上の注意

事項については、本ドキュメントおよびテクニカルアップデートを参照してください。 

 

1. 未使用端子の処理 

【注意】未使用端子は、本文の「未使用端子の処理」に従って処理してください。 

CMOS製品の入力端子のインピーダンスは、一般に、ハイインピーダンスとなっています。未使用 

端子を開放状態で動作させると、誘導現象により、LSI周辺のノイズが印加され、LSI内部で貫通電 

流が流れたり、入力信号と認識されて誤動作を起こす恐れがあります。未使用端子は、本文「未使

用端子の処理」で説明する指示に従い処理してください。 

2. 電源投入時の処置 

【注意】電源投入時は，製品の状態は不定です。 

電源投入時には、LSIの内部回路の状態は不確定であり、レジスタの設定や各端子の状態は不定で 

す。 

外部リセット端子でリセットする製品の場合、電源投入からリセットが有効になるまでの期間、端

子の状態は保証できません。 

同様に、内蔵パワーオンリセット機能を使用してリセットする製品の場合、電源投入からリセット

のかかる一定電圧に達するまでの期間、端子の状態は保証できません。 

3. リザーブアドレス（予約領域）のアクセス禁止 

【注意】リザーブアドレス（予約領域）のアクセスを禁止します。 

アドレス領域には、将来の機能拡張用に割り付けられているリザーブアドレス（予約領域）があり

ます。これらのアドレスをアクセスしたときの動作については、保証できませんので、アクセスし

ないようにしてください。 

4. クロックについて 

【注意】リセット時は、クロックが安定した後、リセットを解除してください。 

プログラム実行中のクロック切り替え時は、切り替え先クロックが安定した後に切り替えてくださ

い。 

リセット時、外部発振子（または外部発振回路）を用いたクロックで動作を開始するシステムで

は、クロックが十分安定した後、リセットを解除してください。また、プログラムの途中で外部発

振子 

（または外部発振回路）を用いたクロックに切り替える場合は、切り替え先のクロックが十分安定

してから切り替えてください。 

5. 製品間の相違について 

【注意】型名の異なる製品に変更する場合は、製品型名ごとにシステム評価試験を実施してくださ 

い。 

同じグループのマイコンでも型名が違うと、内部ROM、レイアウトパターンの相違などにより、電 

気的特性の範囲で、特性値、動作マージン、ノイズ耐量、ノイズ輻射量などが異なる場合がありま 

す。型名が違う製品に変更する場合は、個々の製品ごとにシステム評価試験を実施してください。 
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ご注意書き

1. 本資料に記載された回路、ソフトウェアおよびこれらに関連する情報は、半導体製品の動作例、応用例を説明するものです。お客様の機器・システムの設計におい

て、回路、ソフトウェアおよびこれらに関連する情報を使用する場合には、お客様の責任において行ってください。これらの使用に起因して生じた損害（お客様

または第三者いずれに生じた損害も含みます。以下同じです。）に関し、当社は、一切その責任を負いません。

2. 当社製品、本資料に記載された製品データ、図、表、プログラム、アルゴリズム、応用回路例等の情報の使用に起因して発生した第三者の特許権、著作権その他の

知的財産権に対する侵害またはこれらに関する紛争について、当社は、何らの保証を行うものではなく、また責任を負うものではありません。

3. 当社は、本資料に基づき当社または第三者の特許権、著作権その他の知的財産権を何ら許諾するものではありません。

4. 当社製品を、全部または一部を問わず、改造、改変、複製、その他の不適切に使用しないでください。かかる改造、改変、複製等により生じた損害に関し、当社

は、一切その責任を負いません。

5. 当社は、当社製品の品質水準を「標準水準」および「高品質水準」に分類しており、各品質水準は、以下に示す用途に製品が使用されることを意図しております。

標準水準： コンピュータ、OA機器、通信機器、計測機器、AV機器、

家電、工作機械、パーソナル機器、産業用ロボット等

高品質水準： 輸送機器（自動車、電車、船舶等）、交通制御（信号）、大規模通信機器、

金融端末基幹システム、各種安全制御装置等

当社製品は、直接生命・身体に危害を及ぼす可能性のある機器・システム（生命維持装置、人体に埋め込み使用するもの等）、もしくは多大な物的損害を発生させ

るおそれのある機器・システム（宇宙、海底中継器、原子力制御システム、航空機制御システム、プラント基幹システム、軍事機器等）に使用されることを意図

しておらず、これらの用途に使用することはできません。たとえ、意図しない用途に当社製品を使用したことにより損害が生じても、当社は一切その責任を負い

ません。

6. 当社製品をご使用の際は、最新の製品情報（データシート、ユーザーズマニュアル、アプリケーションノート、信頼性ハンドブックに記載の「半導体デバイスの使

用上の一般的な注意事項」等）をご確認の上、当社が指定する最大定格、動作電源電圧範囲、放熱特性、実装条件その他指定条件の範囲内でご使用ください。指

定条件の範囲を超えて当社製品をご使用された場合の故障、誤動作の不具合および事故につきましては、当社は、一切その責任を負いません。

7. 当社は、当社製品の品質および信頼性の向上に努めていますが、半導体製品はある確率で故障が発生したり、使用条件によっては誤動作したりする場合がありま

す。また、当社製品は耐放射線設計を行っておりません。仮に当社製品の故障または誤動作が生じた場合であっても、人身事故、火災事故その他社会的損害等を

生じさせないよう、お客様の責任において、冗長設計、延焼対策設計、誤動作防止設計等の安全設計およびエージング処理等、お客様の機器・システムとしての

出荷保証を行ってください。特に、マイコンソフトウェアは、単独での検証は困難なため、お客様の機器・システムとしての安全検証をお客様の責任で行ってく

ださい。

8. 当社製品の環境適合性等の詳細につきましては、製品個別に必ず当社営業窓口までお問合せください。ご使用に際しては、特定の物質の含有・使用を規制する

RoHS指令等、適用される環境関連法令を十分調査のうえ、かかる法令に適合するようご使用ください。かかる法令を遵守しないことにより生じた損害に関して、

当社は、一切その責任を負いません。

9. 当社製品および技術を国内外の法令および規則により製造・使用・販売を禁止されている機器・システムに使用することはできません。また、当社製品および技術

を、(1)核兵器、化学兵器、生物兵器等の大量破壊兵器およびこれらを運搬することができるミサイル（無人航空機を含みます。）の開発、設計、製造、使用もし

くは貯蔵等の目的、(2)通常兵器の開発、設計、製造または使用の目的、または(3)その他の国際的な平和および安全の維持の妨げとなる目的で、自ら使用せず、か

つ、第三者に使用、販売、譲渡、輸出、賃貸もしくは使用許諾しないでください。

当社製品および技術を輸出、販売または移転等する場合は、「外国為替及び外国貿易法」その他日本国および適用される外国の輸出管理関連法規を遵守し、それら

の定めるところに従い必要な手続きを行ってください。

10. お客様の転売、貸与等により、本書（本ご注意書きを含みます。）記載の諸条件に抵触して当社製品が使用され、その使用から損害が生じた場合、当社は一切その

責任を負わず、お客様にかかる使用に基づく当社への請求につき当社を免責いただきます。

11. 本資料の全部または一部を当社の文書による事前の承諾を得ることなく転載または複製することを禁じます。

12. 本資料に記載された情報または当社製品に関し、ご不明点がある場合には、当社営業にお問い合わせください。

注1. 本資料において使用されている「当社」とは、ルネサスエレクトロニクス株式会社およびルネサスエレクトロニクス株式会社がその総株主の議決権の過半数を

直接または間接に保有する会社をいいます。

注2. 本資料において使用されている「当社製品」とは、注1において定義された当社の開発、製造製品をいいます。
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